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1 GeoStru Software

The GeoStru Software company develops technical and professional

software for geotechnical engineering, civil engineering, geology,

geomechanics, hydrology, soil testing, geophysics.

Thanks to GeoStru Software you can now use the most effective tools

for your own profession. The GeoStru software represents a complete,

reliable (the computation algorithms are the most technologically

advanced in the research field worldwide), regularly updated, easy to use

tool with an intuitive user interface.

Attention to customer service and the development of software using

modern technologies allowed us to become one of the strongest

companies in the field on international markets. The software – currently

translated into eight languages – is compatible with international

computation rules / normatives and it is one of the most used in over 50

countries worldwide.

GeStru is always present at the main exhibitions in the field, both in Italy

and abroad SAIE Bologna, MADEEXPO Milano, GeoFluid Piacenza,

ExpoEdilizia Roma, Restructura Torino, SEEBE Belgrad, Construct EXPO

Bucuresti, EcoBuild Londra, Construtec Madrid, The Big 5 Dubai etc.

Today working with GeoStru is more than just buying software – it

means having beside you a team of professionals willing to share their

knowledge and experience for excellent results.

There are many areas where the company has specialized in over the

years.

The family of GeoStru products is, in fact, divided into several categories:

Ø Structures

Ø Geotechnics and geology

Ø Geomechanics

Ø In situ soil tests

Ø Hydrology and Hydraulics

Ø Topography

Ø Energy

Ø Geophysics
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Ø Office

For further information about our products please visit our website

http://www.geostru.com

Among the many services offered by GeoStru Software you can use the

free service GeoStru Online that includes software applications on the

web that will help you solve many different problems.

ISO 9001:2008 certification 

CVI Italia s.r.l. awarded GeoStru Software the UNI EN ISO 9001

company certification on 1st June 2009, certificate no. 7007, for

software design and sale. 

1.1 Autoupdate

The software comes with an integrated auto-update system.

A few seconds after opening the software, by moving the mouse pointer

on the indication of version (shown in the bottom right side of the main

window: Geostru _._._._), the user can check whether or not it is

available an update of the software.

If a message will warn the user about the availability of an updated

version, the user can automatically update the software by clicking on

the icon of the message.

In the event that there are no updates available, the message shown will

be ''No updates available.''

1.2 Copyright

The information contained herein is subject to change without notice.

Unless otherwise noted, any reference to companies, names, addresses

and data used as examples are purely coincidental and is intended only

to illustrate the use of the product.

Compliance with all applicable copyright laws is the responsibility of the

user.

http://www.geostru.com
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No part of this document may be reproduced in any form or by any

means electronic or mechanical, for any purpose, without the written

permission of GeoStru Software. However, if the user has the sole

means of access the electronic mean, then it will be authorized, in base

of this document, to print a copy.

1.3 Customer technical support service

For any queries regarding a GeoStru product:

- Consult the documentation and other printed material

- Consult the Help OnLine section

- Consult the technical documentation used for software

development (Web Site)

- Consult the FAQ area (Web Site)

- Consult the GeoStru support services (Web Site)

It is active the new ticket support service developed by GeoStru

Software in order to respond to our users support requests.

This service, reserved to registered users and owners of valid licenses,

allows you to get answers to your requests regarding different aspects

of your programs directly from our specialists (Web Site).

Web Site: www.geostru.com

1.4 Contact

Skype ID: geostru_support_it-eng-spa

Web: www.geostru.com

E-mail: geostru@geostru.com 

http://www.geostru.com
http://www.geostru.com
mailto:geostru@geostru.com
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See the contact page on the website for more information about our contacts and

offices' addresses in Italy and abroad.

2 Utility

2.1 Conversion Tables

Converting slope inclination into degrees and
vice versa 

Inclination (%) Angle (°) Inclination (%) Angle  (°)

1 0.5729 26 14.5742

2 1.1458 27 15.1096

3 1.7184 28 15.6422

4 2.2906 29 16.1722

5 2.8624 30 16.6992

6 3.4336 31 17.2234

7 4.0042 32 17.7447

8 4.5739 33 18.2629

9 5.1428 34 18.7780

10 5.7106 35 19.2900

11 6.2773 36 19.7989

12 6.8428 37 20.3045

13 7.4069 38 20.8068

14 7.9696 39 21.3058

15 8.5308 40 21.8014

16 9.0903 41 22.2936

17 9.6480 42 22.7824

18 10.2040 43 23.2677

19 10.7580 44 23.7495

20 11.3099 45 24.2277

21 11.8598 46 24.7024

22 12.4074 47 25.1735

23 12.9528 48 25.6410

24 13.4957 49 26.1049

25 14.0362 50 26.5651
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Forces conversion

From To Operation Factor

N kg Divide by 9.8

kN kg Multiply by 102

kN Tone Divide by 9.8

kg N Multiply by 9.8

kg kN Divide by 102

Tone kN Multiply by 9.8

 1 Newton (N) = 1/9.81 Kg = 0.102 Kg ; 1 kN = 1000 N

Pressures conversion

From To Operation Factor

Tons/m
2

kg/cm
2 Divide by 10

kg/m
2

kg/cm
2 Divide by 10000

Pa
kg/cm

2 Divide by 98000

kPa
kg/cm

2 Divide by 98

Mpa
kg/cm

2 Multiply by 10.2

kPa
kg/m

2 Multiply by 102

Mpa
kg/m

2 Multiply by 102000

1 Pascal (Pa) = 1 Newton/mq ; 1 kPa = 1000 Pa

2.2 Database of soil physical characteristics

Soil Minimum value Maximum value

Loose sand 0.48 1.60

Average compact sand 0.96 8.00

Compact sand 6.40 12.80

Average compact clayey sand 2.40 4.80

Average compact silty sand 2.40 4.80

Compact sand and gravel 10.00 30.00

Calyey soil with qu< 2 Kg/cm² 1.20 2.40
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Soil Minimum value Maximum value

Calyey soil with 2< qu< 4

Kg/cm²

2.20 4.80

Calyey soil with qu> 2 Kg/cm² >4.80

Approximate values   of Winkler's constant K in Kg/cm3

Soil Minimum value Maximum value

Dry gravel 1800 2000

Wet gravel 1900 2100

Compact dry sand 1700 2000

Compact wet sand 1900 2100

Loose dry sand 1500 1800

Loose wet sand 1600 1900

Sandy clay 1800 2200

Hard clay 2000 2100

Semisolid clay 1900 1950

Soft clay 1800 1850

Peat 1000 1100

Approximate values of the volume weight in Kg/cm3

Soil
Minimu

m value

Maximum

value

Compact gravel 35 35

Loose gravel 34 35

Compact sand 35 45

Loose sand 25 35

Sandy marl 22 29

Fat marl 16 22

Fat clay 0 30

Sandy clay 16 28

Silt 20 27

Approximate values of the friction angle j, in degrees, for soils  

Soil Value

Sandy clay 0.20

Soft clay 0.10

Plastic clay 0.25

Semisolid clay 0.50

Solid clay 1

Tenacious clay 2÷10
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Soil Value

Compact silt 0.10

Approximate values of cohesion in Kg/cm2

Soil Maximum value of E Minimum value of E

Very soft clay 153 20.4

Soft clay 255 51

Medium clay 510 153

Hard clay 1020 510

Sandy clay 2550 255

Loess 612 153

Silty sand 204 51

Loose sand 255 102

Compact sand 816 510

Clayey schist 51000 1530

Silt 204 20.4

Loose sand and gravel 1530 510

Compact sand and gravel 2040 1020

Approximate values of the elastic module, in Kg/cm2, for soils

Soil
Maximum

value of n

Minimum

value of n

Saturated clay 0.5 0.4

Not saturated clay 0.3 0.1

Sandy clay 0.3 0.2

Silt 0.35 0.3

Sand 1.0 -0.1

Gravelly sand commonly used 0.4 0.3

Loess 0.3 0.1

Ice 0.36

Concrete 0.15

Approximate values of the Poisson's ratio for soils

Rock Minimum value Maximum value

Pumice 500 1100

Volcanic tuff 1100 1750

Tufaceous limestone 1120 2000

Coarse sand dry 1400 1500
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Rock Minimum value Maximum value

Fine dry sand 1400 1600

Wet fine sand 1900 2000

Sandstone 1800 2700

Dry clay 2000 2250

Soft limestone 2000 2400

Travertine 2200 2500

Dolomite 2300 2850

Compact limestone 2400 2700

Trachyte 2400 2800

Porphyry 2450 2700

Gneiss 2500 2700

Serpentine 2500 2750

Granite 2550 2900

Marble 2700 2750

Syenite 2700 3000

Diorite 2750 3000

Basalt 2750 3100

Approximate values of specific weight for some rocks in Kg/m3

Rock Minimum value Maximum value

Granite 45 60

Dolerite 55 60

Basalt 50 55

Sandstone 35 50

Calyey schist 15 30

Limestone 35 50

Quartzite 50 60

Marble 35 50

Approximate values of the friction angle j, in degrees, for rocks

Rock

E n

Maximum

value

Minimum

value

Maximum

value

Minimum

value

Basalt 1071000 178500 0.32 0.27

Granite 856800 142800 0.30 0.26

Crystalline schist 856800 71400 0.22 0.18

Limestone 1071000 214200 0.45 0.24

Porous

limestone

856800 35700 0.45 0.35

Sandstone 428400 35700 0.45 0.20

Calyey schist 214200 35700 0.45 0.25

Concrete Variable 0.15
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Approximate values of the elastic module and Poisson's ratio for rocks

3 Introduction

Stratigrapher is a program for the graphic/textual documentary

representation, in columnar form, of results of field survey combined as

opportune with other data as to the composition of a terrain to the

required depth.

As a related matter, also well construction characteristics may form the

subject to be recorded.

The representative model may be designed by the user utilizing a built in

Template editor, that yields templates for representation of either

penetrometric investigation or well construction, much as a word

processing document templates model document presentation. Default

templates are provided for each type (Well/penetrometric) and based on

these the user is enabled to design personalized versions. Each template

thereafter dictates the information requirement of that type.

The columnar representation permits to represent the lithologic

characteristics of the strata, documentation of samples and analysis

(Pocket, Vane test, % Core depth, R.Q.D., Ground water table, Open

tube or Casagrande piezometer etc.) against a user tailored depth scale.

Patterns and bitmaps to characterize the individual lithotypes may be

applied directly from attached, user modifiable, libraries (lithotypes).

Further, a set of vector textures or colors can be used to characterize

lithotypes.

The resultant columnar documentation can be saved and updated as

required and is available, upon completion, for import into the

stratigraphy of other GeoStru software such as Slope Stability Analysis,

LoadCap, MP, etc.

Insertion (Recording soil layers) of information consists in selection of

the relevant tool from a list and dragging it to the required column at the

desired elevation.
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4 Home

4.1 Heading

This command in the Home-Edit menu opens a window in which,

company data, logo and general data regarding the project may be

entered.

The characteristics of the headers are determined by the template

document (see editor ) used for the project.

4.2 Scale

The parameters for the Depth scale  may be set in the window that

opens at this command.

The variables to be declared are: 

· Scale -the representation scale . i.e. 1:xxx

· Step - the step interval (for marks on the depth scale)

· Initial elevation - elevation at which to start the depth

scale (and origin of depth/thickness data)

· Decimals - number of decimals to display

4.3 Add worksheet

The command "Add sheet" offers the possibility to add new worksheet

to the project.

4.4 Modify elements

Every column element inserted in the various columns (lithology,

description, GWT level, piezometer etc.) may be modified. Select the

command Modify element in the Edit menu. This activates the function.

While the function is active the pointer alters to a pointing finger

whenever it is over an element (in a column).

To actually alter the element, click on it. This will cause a dialog window

to be opened, in which the desired modifications may be applied. 

Modify elements command remains active until deactivated (by pressing

Esc key on the keyboard)

11
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To delete elements select Delete elements command and click on the

element to be deleted.

 

4.5 Template editor

Stratigrapher provides the mean of recording, archiving, and

reuse of borehole data collection. Documentation is envisaged to take

the form of multiple column documents in which each column records a

type of data against a common depth scale. 

Template editor is a tool whereby the model of such columnar

documentation sheets may be user tailored. As such it provides tools for

the design of the document by specifying: spaces for company data,

project headers, column headers, column body and note & signature

area, and column dimensions, aspect, etc. These specifications are

stored in template files (extension .stl) and may be selected at will by the

user. With the program are supplied two basic templates, one for

penetrometric investigations and another for well description. When first

started the software asks the user to choose a template to be loaded

(that can be changed at any time using the command Change template).

The editor is available from the Format menu. The editor operates by

modifying the current template. The changed template should then be

saved under its new name, to become the new one.

The Editor displays the template in edit, and shows in the pane on the left

an hierarchical tree list of the items that may be used to form the new

template. The top level items are:

· Page aspect

Enables sheet background color or background image to be specified.

· Page Format

Set up page size and orientation. Size may be A4 or A3

· Boxes

The program envisages that the sheet is divided into

rectangular boxes (with/without border) for such items as

logos, company data, document header, column headers,

column body, and free text. This item enables the placing,

aspect, borders, and size of these rectangular box areas to be

defined. The user is advised to set a border on each box during

design phase. Such borders are highlighted (red) when they are
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the object of edit operations. If not required on the finished

document, they may be removed after design completion.

· Fonts

Font name, size, color, and whether bold for the textual

elements can be defined within this item. When the element

text to which the font applies is selected, it is highlighted (red)

on the form.

· Labels 

They are used to customize the data (constants and variables)

that will be displayed and managed on the model. For these

data, it is necessary to indicate the location that is expressed in

coordinates relative to the box on the sheet format chosen

(mm). For example, if you enter the 1s t line company data, the

coordinate of the position is relative to the location of the

upper left corner of the box Company data. Given the

objective difficulty in determining the exact location where you

want to place a text you can use the command "use mouse"

and pointing directly to the wanted location on the model.

· Columns

Lists the characteristic columns that can be inserted in the model.

Both penetrometric and well types are selectable. Their order

corresponds to the display order and cannot be altered.

Column title, whether title is to be inserted vertically, and column

width (mm) can be specified. Columns abut to each other and

changing the width of one will reposition the following ones.

· Dividing Lines

Dividing lines, up to a maximum of 20, may be inserted. A specific use

is the division of the heading area into boxes for each item. When the

element to which the font applies is selected, it is highlighted (red) on

the form.

The entries required are: Pairs of start and end vertices, line type and

color. Lines are included or not by the use of the I checkbox. A mouse

icon button enables the vertices to be selected with the mouse.

4.6 Open web template

On the Web there are different templates for different types of tests. If

you have an Internet connection, click Open web template from the

Home - Format menu, then select the desired model from those
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available. This action will allow the program to launch the operations of

downloading the chosen template and make it active for any

customizations.

Some templates available online

4.7 Options

Textures path

In this pane, appear the paths to the folders that contain the images

(textures), distributed in four folders for Cohesive, Cohesionless, Rocks,

and Others, that may be used to symbolize various soil types.

When the program is installed these paths are initialized to the parent

folder of the program (default: GeoStru). It is in this default folder that

the textures provided by GeoStru Software are placed by default.

If the placing is other than default it will be necessary to update the paths

so that they point to the effective textures folder.

The user may add personalized images or even photos as desired to the

existing libraries. 

Textures can also be downloaded from the web (see picture below). To

start the download procedure click in the left side pane on "Search

resources on Web". To add the texture on the stratigraphic column just
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drag it with the mouse in the Lithilogy column of the template you are

working on.

Search resources on web

Signed elev.

Select this check box to see the (-) sing on the model for the negative

elevations.

Invisible legend

Select this option to hide the legend in the bottom of the stratigraphic

model.

Lithologic layers options

Show elevation

Select this option to display the bottom elevation of an inserted layer.

Show thickness

Select this option display the thickness of an inserted layer

Layer separation line
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Select this option to display or not the separation lines between layers.

The choice can be made between Absent, Complete or Only on

stratigraphic column.

4.8 Changing the background color of textures

To change the background color of the textures, go to the texture

installation file, and run the TEXTURES.exe executable.

The following window will appear on the screen, select the texture you

want to change.

Hover your mouse over the texture and click on the colored background,

as in the following image.
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Select the new color you want to assign to the textures.

Choose a name and confirm the changes with the save button.
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5 Graphic model

5.1 Depth scale

A depth ruler can be drawn on the graphic model to easier read the

depths. The ruler may be scaled by selecting the command Scale  in

the Tools menu or corresponding toolbar button.

The column can be customized using the command "Modify elements".

Click, on the model, on the depth scale column.

In the resulting dialog window the desired scale (1:100; 1:200, etc.)

may be entered. Step intervals in the depth figures, the number of

decimals, and the origin elevation (or depth) of the column may also be

specified here.

Notes: The origin at which the depth ruler should start may be set at the

convenience of the user. Thus zero or a positive or negative figure may

be set as most relevant to the study in question. In all cases the depth

ruler will indicate levels that descend from this initial value, so that where

10
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a positive figure is selected the figures will progress to zero and

thereafter to negative ones.

When actual elevation is used (as opposed to layer thickness) the level

of each lithologic boundary will necessarily be below the level of origin of

the depth scale.

5.2 Lithology

The lithological textures that define the stratigraphy of the terrain are

entered in this column. Use the mouse to select and drag the image that

is to represent the layer material from those displayed on the left in the

textures pane, onto this column. When the mouse button is released, a

dialog window opens that contains entries for the following parameters:

· Elevation

Depth of lower layer boundary (or layer thickness) . The upper edge

being either the previous layer or field level. Whether depth or

thickness are to be used is determined in the Options  command

(Preferences menu).

· Lithology

Type of representation of the layer, to be selected from drop down
list. The options are: None, Bitmap, Vector, or colour.

· Texture

The actual texture or color to be used if any.

· Description

The description  text associated with the texture is placed in the
description column. This may be expanded as required.

· Margins

A box each for upper and lower text margins in mm. Allows text from
adjacent descriptions to overlap  the depth boundaries.

· Core and RQD %age  

Values and color representation selection.

The lithological representation can be done using screens in Windows

Bitmap format, filling with uniform color, patterns vector, image

downloaded from the web. In the Elevation column may be given the

absolute height or thickness of the layer depending on the setting in

Home - Options - Lithological layers options.

13

19

19
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The use of vector textures allowsto represent the lithology with

elements that are scalable and customizable at the moment. Each

vector element physically occupies 1x1 mm and the value "Scale" sets

the desired display to fill the layer. The rotation changes orientation of

the figure appears; colors, line and background, determine the color of

the layer. To assign a texture vector, as for raster textures, select the

item and drag in with the mouse on the model to the desired elevation.

 

5.3 Description

Text may be entered in the Description column.

Text originates in the terrain description of the texture file (or the name

of the file if a text cannot be found. This can be edited when texture is

applied and the Layer detail dialog window is displayed (see Lithology ),

or else using the Modify elements  command.

In cases where the text to be used overruns the space dictated by the

elevation boundaries, the user may find it useful to alter the margin sizes

(lower and upper) of this and adjoining layers to obtain more space. (i.e.

increase the lower margin of the layer with excess text, to provide more

space, and increase the upper margin of the next layer, thus dropping

down its own description and making space for the excess from the

layer above).

5.4 Elevation

The depths of the transition from one lithological layer to the next are

recorded in this column. The values may be absolute or with signs. (See

Depth scale ).

All depth values in this column should of course be inferior to the starting

value and will be negative if the origin value is zero or below.

If desired instead of entering a depth figure an interval (e.g. layer

thickness) can be entered.

To switch between depth and thicknesses in this column, select the

appropriate check box in the Options command (Preference menu).

The switch is dynamic so that the figures alter in response to the setting.

5.5 Core % R.Q.D.

18

10

17
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Core recovery depth percentage or RQD values, for each layer are

assigned in the Layer detail dialog window, which opens when textures

are assigned to individual layers. At the same time the various values

may each be characterized by a color.

In the Modify elements command item it is possible to alter the initial

values.

The width and colors of the column can be set or altered in the Template

Editor.

5.6 S.P.T.

SPT field results with hollow (P.A.) or solid (P.C.) drill bit at determined

depths may be entered in this column.

To insert this information click on the SPT title the instruments list on the

lower left part of the screen, and drag to the column area.

In the 'S.P.T.' dialog window that appears the depth level, type of bit, and

results text can be entered.

The column is customized in Templates editor.

P.C.= Punta chiusa – Open tip;

P.A.= Punta aperta – Closed tip.

5.7 P.T. - V.T.

Into this column may be entered the results of the tests that are

performed in the field: pocket and vane tests. 

To insert this information click on the method in question (pocket or

vane) from the Tools pane list on the lower left part of the screen, and

drag to the column area. In the 'PT or VT Specification' dialog window

that appears the depth level and results text can be entered.

The column is customized in Templates editor.

 

5.8 Samples

This column is intended to carry information regarding the type of

samples  encountered.

From the Tools window list at the lower left side of the screen the

sample and drag it to the column area.
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The elevation boundaries and the selected method can then be entered

in the 'Samples' dialog window that opens thereby, as well as a color to

indicate this sample type.

The column is customized in Templates editor.

5.9 Drilling method

Into this column may be entered the drilling method(s) used in sampling

the terrain.

To insert this information click on the method in question from the Tools

pane list on the lower left part of the screen, and drag to the column

area.

A dialog window (Drilling methods) appears the method and depth level

can be entered.

The column is customized in templates editor.

5.10 Stabilization method

This column is intended to carry information regarding the type of

borehole stabilization employed (Bentonite slurry, or metal jacket, etc.).

From the Tools window list at the lower left side of the screen select

stabilization and drag it to the column area.

The elevation and the selected method can then be entered in the

"Stabilization methods" dialog window that opens thereby.

The column is customized in templates editor.

5.11 Sample box

Sample box specifications may be entered in this column.

To insert this information click on the Sample box title the instruments

list on the lower left part of the screen, and drag to the column area.

In the 'Sample box' dialog window that appears the depth level and box

identifying text can be entered.

The column is customized in templates editor.

5.12 Well

By the use of appropriate templates, it is possible to generate

Statigrapher sheets that document the construction specifications of
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wells. One such template that may be used as a model for others is

provided with the software.

The elements describing the well are:

· Plug

· Closed tube

· Filter

The first element we're going to enter, whatever it is, on the window

that appears when you drag the mouse, we must indicate some basic

parameters:

Diameter of drill hole

This value, graphically, will coincide with the width of the Well column and

all the diameters of the elements will be compared on this measure. For

example, if on an A4 sheet the column well measures 5 cm and we

indicate 2000 mm as D.P., a closed tube of 1000 mm in will be drawn to

2.5 cm.

Filling

As filling is used a lithological texture, selectable as any bitmap.

Then are required the parameters of the specific component:

Diameter

Measures the diameter of the element.

Elevation

Lower level. The upper elevation is determined from the preceding

element or from ground level if it is the first element.

Overlap

Indicates the extent of overlap with respect to the item that precedes it.

Note: Remarks or description of the item.

 

Observations:

When you specify a measure or diameter there is no reference to the

unit of measurement used because is not decisive to the proper

arrangement of the elements. In fact, all the horizontal dimensions

(diameters) are calculated in relation to the diameter of the hole which

always coincides with the total width of the column. To display the unit of

measurement used it is necessary to describe it in the notes.
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5.13 GWT level

This column permits the GWT depth reported during terrain investigation

to be recorded.

Select the item 'Water table level' from the Tools window list of found in

the column on the lower left of the screen and drag to the column area.

Releasing the mouse button opens a dialog window in which the depth

can be entered.

The column is customized in templates editor.

 

5.14 User Columns

These columns are available to the user for whatever purpose may be

found useful.

The size, header, and format of the columns are customized in the

template editor.

To enter data, select the title assigned (above) from the tools pane, and

drag to the column area.

A dialog window opens and allows the depth and a text to be entered.

5.15 Chart columns

In these columns can be drawn a series of experimental data defined by

user. The graphic can be customized with a set of options.

5.16 Piezometers

Into this column may be recorded data on piezometers used in the

borehole: electric, open pipe and Casagrande. 

The open pipe piezometer is represented with a bollard, while that of

Casagrande with a gray rectangle.

To insert one of these instruments click in the Tools pane, and drag it to

this column. Parameters that can be entered in the dialog window that

appears are: Inclinometer/Piezometer, depth, type, Casagrande depth

where relevant.
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The user can enter an unlimited number of piezometers. On the column

header it shows the number of the element (1,2,3, ..) followed by the

code P/I that identifies whether it is a piezometer or an inclinometer.

The column is customized in templates editor.

Open pipe piezometer

Casagrande piezometer

Electric piezometer
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6 Geoapp

Geoapp: the largest web suite for online calculations

 
The applications present in Geostru Geoapp were created to support the

worker for the solution of multiple professional cases.

Geoapp includes over 40 applications for: Engineering, Geology,

Geophysics, Hydrology and Hydraulics.

 

Most of the applications are free, others require a monthly or annual

subscription.

 

Having a subscription means:

 

• access to the apps from everywhere and every device;

• saving files in cloud and locally;

• reopening files for further elaborations;

• generating prints and graphics;

• notifications about new apps and their inclusion in your

subscription;

• access to the newest versions and features;

• support service throught Tickets.

6.1 Geoapp Section

General and Engineering, Geotechnics and Geology  
 

Among the applications present, a wide range can be used for

Stratigrapher. For this purpose, the following applications are

recommended:  

 

Ø NSPT Form

Ø Horizontal reaction coefficient of foundation piles

Ø Load test on poles

Ø Liquefaction (Boulanger 2014)

Ø Reinforced earth

Ø Soil Classification

Ø Bearing capacity

Ø Lithostatic tensions

7 Import from other GeoStru programs

The data processed by the software Dynamic Probing and Static Probing

https://geoapp.geostru.eu/?lang=en
https://geoapp.geostru.eu/apps/?lang=en
https://geoapp.geostru.eu/app/formulario-nspt/
https://geoapp.geostru.eu/app/kh/
https://geoapp.geostru.eu/app/prove-di-carico-su-pali/
https://geoapp.geostru.eu/app/liquefazione/
https://geoapp.geostru.eu/app/terre-rinforzate/
https://geoapp.geostru.eu/app/classificazione-delle-terre/
https://geoapp.geostru.eu/app/carico-limite-e-cedimenti/
https://geoapp.geostru.eu/app/tensioni-geostatiche/
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can be imported and displayed in Stratigrapher using an appropriate

template. To import choose Import ... command from the File menu and

select the *.edp file you want to import, the processed data will be

represented on the model.

8 Exception not managed at startup

Exception not managed at startup of the program type "Argument

Exception: Path cannot be the empty string or all whitespace."

CAUSE

The error is due to the absence of valid textures paths during the first

start of the program in the Registry keys of the System.

SOLUTION

1. Open the registry by typing in the windows search bar "regedit" and

clicking on the first result.
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2. Using the side panel on the left of the window, navigate to the path:

Computer\HKEY_CURRENT_USER\SOFTWARE\VB and VBA Program

Settings\GEOSTRU STRATIGRAPHER\Settings

3. If the values for the rows " Rocce (Rocks)", " Terreni Coesivi

(Cohesive Soils)", "Terreni incoerenti Inconsistent Soils" and

"Hatch" (these names remain unchanged regardless of the language
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selected for the software) on the third column ("Data") are empty, right

click on the row individually and select "Modify":

4. At this point, enter in "Value data" the valid path of the various

textures.

By starting Stratigrapher, you should no longer find the error.

9 Shortcut commands

The bar shown below can be used for a variety of functionalities:

1) With the shortcut letters of the  menu followed by Enter you have

quick access to commands.

   Ex: N + Enter to create a new file.

2) You can ask a question followed by ? + Enter. In this a case advanced

research will be made   in Help .

Ex.: Seism+?+Enter for information on seismic analysis.

3) Opening a program in a quick way.

Ex.: Slope+Enter to open GeoStru Slope software.
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4) Quick access to GeoStru contacts. 

Ex.: Contact+?+Enter to access the contact list. 

5) Quick acces to web features: 

Ex.: www.geostru.com+Enter or geostru@geostru.com. + Enter 

http://www.geostru.com
mailto:geostru@geostru.com.
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